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Please read this chapter carefully before using this product!

This chapter introduces the safety precautions before using this product. Please
make sure the content of this chapter is fully read and understood before installation
and usage. Our company will not undertake any responsibilities for any damage or
injury caused by improper operations because of ignoring relevant warning in this

operation instruction.

Before operating this device, relevant professional personnel shall read this

instruction carefully and well understand the content.
Operation instructions and warnings:
The following standard definitions will be adopted in this operation instruction.

Danger! Ignoring of safety precautions may cause personal death, serious personal

injury or serious equipment damage.

Warning! Ignoring of safety precautions may cause personal death, serious

personal injury or serious equipment damage.

Caution! Ignoring of safety precautions may cause a slight personal injury or
equipment damage, especially the damage of device or the equipment protected by

the device.
® Danger!

When the primary system is live working, secondary open circuit for the current
transformer connected to the device is absolutely forbidden, and the open of this

circuit may cause extremely dangerous high voltage.
® Warning!

Some parts of the device may have high voltage when the electrical device is running.

Improper operation may cause serious personal injury or equipment damage.

Only qualified professional personnel are allowed to operate the device or work
nearby the device. The operators professional shall well understand the precautions,

working flows and safety regulations mentioned in this instruction.
® Caution!

Grounding terminals of the device shall be firmly grounded.



The device is only permitted to run in atmospheric environment that specified in the
technical specifications, and abnormal vibrations shall be avoided in its running

environment.

When connect the AC voltage current circuit or power circuit, please make sure they

conform to the rated parameters of the device.

When the output terminals of the device are connected to external circuit, please

check carefully the voltage of external power to prevent overheating of the circuit.

Carefully check the cable connected to the device, preventing applying too much

external force on it.
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1.1 Description

RWK-LC Smart Switch Controller is medium voltage overhead line grid monitoring
unit, it can be equipped with RCW(RVB) type vacuum circuit breaker for achieve of
automatic monitoring, fault analysis and event records.

Its given to us a safety power grid for cutting line fault and automatic recovery
operation and power automation.

RWK-LC series is suitable for up to 35kV outdoor switchgear using, include: vacuum
circuit breakers, oil circuit breakers and gas circuit breakers.

RWK-LC intelligent controller is gathering with line protection, control, measurement
and monitoring of voltage and current signals integrated automation and control
devices outdoors.

RWK is an automatic management unit for single way/multi ways/ring network/two
power sourcing, provided with all voltage and current signals and all functions.
RWK-LC column switch intelligent controller supports:

Wireless (GSM/GPRS/CDMA), Ethernet mode, WIFI, optical fiber, power line carrier,
RS232/485, R145 and other forms of communication, and can access other station
premises equipment (such as TTU, FTU, DTU, etc.).

1.2 Protection

49 Thermal Overload (Over load)

50 Instantaneous Overcurrent (Ph.OC)
50G/N/SEF  Instantaneous Sensitive Earth Fault (SEF)
27/59 Under/Over Voltage (Ph.OV/Ph.UV)

51c Cold load pickup (Cold load)

1.3 Supervision

60CTS CT Supervision
60VTS VT Supervision
1.4 Control
79 Auto Reclose
86 Lockout

CB Control

1.5 Features
Password Protection — 2 levels.

50Hz systems and two phase/three phase wiring method are available, so that the
use scope of device is extended.



Protection configuration is complete, and all protection functions can be switched on
and off flexibly.

4-way intellectual switching value input.

Large capacity flash memory can record at least 100 times of historical events, and
no data will loss even the power is off.

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers,
and the operation is simple and reliable.

The device has complete self-inspection function to in-service monitor the working
conditions of various parts of the device, ensuring the reliability of the device.

1.6 Monitoring Functions

Primary Currents Phases and Earth Direction
Secondary PT Voltage

Frequency

Binary Input/Output status

Trip circuit healthy/failure

Time and date

Fault records

Event records

1.7 Hardware

4CT 1 VT 4 Binary Inputs 2 Binary Outputs
4CT 2 VT 4 Binary Inputs 2 Binary Outputs
1.8 Data Storage and Communication
RS485, RS232, R145 port

Protocols —-IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU
Event Records

Fault Records

Measurands

Commands

Time Synchronism

Viewing and Changing Settings



Chapter 2: Technical Performance Index

2.1 Inputs and Outputs

v
=
Q
[
o
0
c
=
=
o
=
-+
=l
3
b=
c
@

Sensitive Earth Current Inputs

g
8
Q
o
-t
=
<
c
-
7]
~



Auxiliary Supply

Binary Inputs

2.3 Serial Interface




2.4 Data Storage

2.5 Mechanical Tests

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I

Shock and Bump --- IEC 60255-21-2 Class I

Shock and Bump --- IEC 60255-21- 3 Class 1

Mechanical Classification




2.6 Electrical Tests
Insulation --- IEC 60255-5

Type Level

Between any terminal and earth 2.0 kV AC RMS for 1 min
Between independent circuits 2.0 kV AC RMS for 1 min
Across normally open contacts kV AC RMS for 1 min

High Frequency Disturbance --- IEC 60255-22-1 Class Il

Type Level Variation
Common (longitudinal) mode 2.5 kv <5%
Series (transverse) mode 1.0 kV <5%

High Frequency Disturbance --- IEC 60255-22-2 Class IV

Type Level Variation

Contact discharge 8.0 kv <5%
Fast Transients --- IEC 60255-22-4 Class A (2002)

Type Level Variation

5/50 ns 2.5 kHz repetitive 4 KV <5%

Surge Immunity --- IEC 60255-22-5

Type Level Variation
Analog Inputs: 4.0 kV <10%

Line to Earth

Case, Aux Power & I/O: Line to Earth 2.0 kV <10%
RS485 Comms port: Line to Earth 1.0 kV No Data Loss
Analog Inputs: 1.0 kV <10%

Line to Line

Case, Aux Power & I/0O: Line to Line 1.0 kv* <10%

* Note 45ms DTL pick-up delay applied to binary inputs
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Conducted Radio Frequency Interference --- IEC 60255-22-6
Type Level Variation
0.15 to 80 MHz 10V <5%

Radiated Radio Frequency --- IEC 60255-25

Type Limits at 10 m, Quasi-peak
30 to 230 MHz 40 dB(uV)
230 to 10000 MHz 47 dB(uV)

Conducted Radio Frequency

Type Limits

Quasi-peak Average
0.15 to 0.5 MHZ 79 dB(LV) 66 dB(LV)
0.5 to 30 MHZ 73 dB(pVv) 60 dB(pV)

Radiated Immunity --- IEC 60255-22-3 Class III

Type Level
80 MHz to 1000 MHz Sweep 10 V/m
1.4GHz to 2.7GHz Sweep 10 V/m

80,160,380,450,900,1850,2150 MHz Spot 10 V/m
2.7 Climatic Tests
Temperature --- IEC 60068-2-1/2

Operating Range -10°C to +55°

Storage range -25°C to +70°
Humidity --- IEC 60068-2-78

Operational test 56 days at 40°C and 93%

relative humidity

11



3.1 Function Description
Under Voltage (Ph.UV)

The device take the PT voltage as the criterion for under voltage protection.
Action Logic diagram:

| ua<user |

| CB in closed position I &Trip

| Ph.UVisrun |

Note: Run is “V”, Stop is “x".
UA—Secondary PT voltage Uset—Pickup voltage T—Delay time

Power on

The device will control the CB to close when the PT voltage greater than pickup
voltage.

Action Logic diagram:

| Ua>Uset |

| CB in opened position } &Cloae

| Power onisrun II

Note: Run is “V"”, Stop is “x".
UA—Secondary PT voltage Uset—Pickup voltage T—Delay time

Over Voltage (Ph.OV)

The device take the PT voltage as the criterion for over voltage protection.
Action Logic diagram:

[ UA>Uset |

| CBin closed position I & I Trip

| Ph.OV is run {

Note: Run is “v"”, Stop is “x".
UA—Secondary PT voltage Uset—Pickup voltage T—Delay time

12



51c Cold Load Pickup (Cold Load)

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered
for a prolonged period, this can impose a higher than normal load-current demand
on the system which could exceed normal settings. These conditions can exist for an
extended period and must not be interpreted as a fault. To allow optimum setting
levels to be applied for normal operation, the cold load pickup feature will apply
alternative current settings for a limited period. The feature resets when either the
circuit breaker has been closed for a settable period, or if the current has reduced
beneath a set level for a user set period.

Action Logic diagram:

| Cold load is Run I

|1 set>IA>Iset f—
[T ser>IB>Iset —>1 &t+——{ t }F—mrip
| ['set>IC>Iset Ii

| Ph.OCisRun |

Note: Run is “V”, Stop is “x".
I'set—Cold load pickup current Iset—Ph.OC pickup current T—Delay time

50/51/51V/67 Phase Fault (Ph.OC)

Three sections phase overcurrent protection for lines include Ph.OC1 (instantaneous
overcurrent protection), Ph.OC2 (definite time overcurrent protection) and Ph.OC3
(overcurrent protection). All of which are definite time actuate features.

Action Logic diagram:

_‘
IB>Iset > 1
i aa | B

| Ph.OCisRun |

Trip

Note: Run is “V"”, Stop is “x".
IA IB IC—Measured current Iset—Pickup current T—Delay time

50G/51G/50N/51N Sensitive Earth Fault (SEF)

The sensitive earth fault protection is definite time limit.

Action Logic diagram:

3lo>loset
e o
| SEF isRun [

Note: Run is “V", Stop is “x".
3I0—SEF current I0set—Pickup current T—Delay time

13



79 Auto - Reclose (Reclose)

A high proportion of faults on an overhead line network are transient and can be
cleared quickly by high speed tripping followed by an automated circuit breaker
reclose sequence.

The function provides phase fault and earth fault/sensitive earth fault sequences of
up to 5 trip i.e.4 reclose attempts before lockout, and the charging period of the
reclose is 10 seconds.

Action Logic diagram:

| Ph.OC Trip |
|
|

| Reclose is Run

| Reclose count #+0 |

& 'Cl()se

| Reclose unlock

| Manual trip

|
|
|
|
| Remote trip I o
|
|

| After close >10S

Note: Run is “V”, Stop is “x".
Reclosing acceleration (Recl.ACC)

When switching on reclosing acceleration, if accidents happened in 3S after the
reclose is operated, the phase over current protection will accelerate the operation.

Action Logic diagram:

.

Trip

After reclose =35

|
| Recl.ACC is Run I

Note: Run is “V”, Stop is “x".
IA IB IC—Measured current Iset—Pickup current T—Delay time

Manual closing acceleration (Manu.ACC)

When switching on manual closing acceleration, if accidents happened in the exit
time after operated the close, the phase over current protection will accelerate the
operation. The exit time of acceleration can be adjusted.

Action Logic diagram:

14



IB>Iset 5
IC>1set

I Manual/Remote Close li& T Trip
| After close <Exit time I—

| Manu.ACC is Run I

A\Y ”

Note: Run is “V"”, Stop is “x",
IA IB IC—Measured current Iset—Pickup current T—Delay time

Prepaid (Optional features)

It is used to connect the dosing tank, the device will control the CB to trip when the
dosing tank is in deficit.

Action Logic diagram:

I CB in closed position II

&— 1 F—mi

| Prepaid is run E

Note: Run is “V”, Stop is “x".
3.2 Constant Value Parameters

All values are given primary side.

Under Voltage (Ph.UV)
Description Setting range Step length
Pickup voltage 0~999.9v 0.1v
PH.UV
Delay time 0~99.99S 0.01S
Power on
Description Setting range Step length
e Pickup voltage 0~999.9V 0.1v
OWETON  pelay time 0 ~99.995 0.01S
Over Voltage (Ph.OV)
Description Setting range Step length
Pickup voltage 0~999.9V 0.1v
PH.OV
Delay time 0~99.99S 0.01S
51C Cold Load Pickup (Cold load)
Description Setting range Step length
Pickup current 1~6000A 0.1A
Cold load ;
Delay time 0~99.99S 0.01S
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50/51/51V/67 Phase Fault (Ph.OC)

Description Setting range Step length
Pickup current 0.1 ~6000A 0.1A
PH.OC1 ;
Delay time 0~9.99S 0.01S
Pickup current 0.1 ~6000A 0.1A
PH.OC2
Delay time 0~9.99S 0.01S
Pickup current 0.1 ~6000A 0.1A
PH.OC3 ;
Delay time 0~99.99S 0.01S
50G/N Sensitive Earth Fault (SEF)
Description Setting range Step length
Operating mode 1.Alarm 2.Trip
SEF Pickup current 0.1~999.9A 0. 1A
Delay time 0 ~600S/M 0.1S5/M
79 Auto - Reclose (Reclose)
Description Setting range Step length
Reclose count 1:0One 2:Two 3:Three 4:Four
Reclose Delay time 0~99.99S 0.01S
Reset time 1.2 ~180S 0.1S
Reclosing acceleration (Recl.ACC)
Description Setting range Step length
Pickup current 0.1 ~6000A 0.1A
Recl.ACC
Delay time 0~9.99S 0.01S
Manual closing acceleration (Manu.ACC)
Description Setting range Step length
Exit time 0.1~9.99S 0.01S
Manu.ACC  Pickup current 0.1 ~6000A 0.1A
Delay time 0~9.99S 0.01S
Prepaid (Optional features)
Description Setting range Step length
Prepaid Delay time 0~99.99S 0.01S

16



Commu.

Alarm

Closed

oﬂo

———
Local (\;>\liemote ‘
=+

Diection Key

Rocker Switch

The operator interface is designed to provide a user friendly method of controlling,
viewing menus, entering settings and retrieving data from the relay. 11 buttons are
provided for navigation around the menu structure.

4.1 LEDs

Reclose

Operation Status Operation Status



LED Categories

Name

Run

Commu

Alarm

Closed
Opened

Action

Reclos
OC.F
Earth.F

Lockout

4.2 Keypad

Color

Green

Green

Yellow

Red

Green

Red

Red

Red

Red

Red

The main keys

ON

crash

No communication

Device failure or
protection alarm

Switch is on
Switch is off

Protective action

Reclose export
Over current alarm
Ground fault action

Reclosing lockout
alarm

LED Status
OFF

crash

No communication

Running normally

Switch is not on
Switch is not off

No protective
action

Normal
Normal
Normal

Normal

User actions are mainly concentrated on the operation panel.

O

Esc

0

of=

7

n

O

Enter

Diection Key
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Flashing

Working
properly

Normal
communication



~

ey Function

Increase the number

Reduce the number

Move up or page up

Move down or page down

Move left

Move right

a0 RN

Return to the superior or Cancel the operation

Enter Enter the menu of confirm the operation

When you press the button, the buzzer of device will sing make a sound, so that
the operation is valid; if not, please do it again.

Operation buttons

Key Function
Reset Touch reset button, you can reset protect information
C]()se Touch closing button, close switch

Op en Touch tripping button, trip switch

When you press the button, the buzzer of device will make a sound, so that the
operation is valid; if not, please do it again.

Note: When you press the closing-button or tripping-button, you must make sure the
device is unlock; if the lockout-light is on, please press the reset-button to reset the
device, so that you can close or trip the switch.
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4.3 LCD

A 4 line by 16 character liquid crystal display with power save operation indicates the
relay identifier, settings, instrumentation, fault data and control commands.

4.4 The Main Menu

Press “Enter” when on the main screen, as shown below, including “EDIT" and
“VIEW"” menu item. Select the corresponding menu item with the [<] key, [—] and

press "Enter" button to enter the corresponding sub-menu, press the “ESC” key to
return to the previous screen.

Primacy Menu

20



4.5 Submenu
Edit submenu

Choose the edit options, the screen will enter the submenu of the Edit menu, as
shown below, the submenu includes “Relay”, “Para”. “Chnl”, “Clr”, “Time",

“Comm”, “Fac”, "“Test”.

Time Comm

Submenu of edit

Enter “Relay” submenu, you can modify the protection
feature.

Enter “Para” submenu, you can modify or view other
parameters. Like communication address, baud rate,
password, trip and close pulse time.

Enter “Adj.” submenu, current and voltage values can be
corrected, press the function key "Enter" to be modified.

Enter “Clr.” submenu, you can clear out the trip report, the
alarm report, the SOE report, the count report and all
report.

Enter the “Time” submenu will modify or check the time.

Enter "Comm” Sub-menu, choose the way to
communication, it include "GSM"and “GPRS".

Enter “Fac.” Sub-menu, modify and view the factory
settings.

Enter “Test” Sub-menu, it can test the life of the switch,
set the number of reclosing and the interval time of each
reclosing.

21



View submenu

Choose the view options, the screen will enter the submenu of the View menu, as
shown below, the sub-menu includes “Meter”, “RPT”, “Relay”, “Input”, “Ver”.

[NNNNSNSSN

Me ter SN

Relay

View submenu

Enter “Meter” submenu, you can view the primary side
measurement data include: PT voltage, phase current, zero
sequence current, frequency, phase angle.

Enter "RPT” submenu, you can view trip report, alarm report,
SOE report, count report.

Enter “Relay” submenu, you can view each protection feature
is invested and set up the parameters

Enter the “Input” submenu, you can view the input signal.
The input signal includes: Breaker close, Prepaid open,
Prepaid close, Spring ready.

Enter “Ver” submenu, you can view the product model, serial
number and date of manufacture.

4.6 Entering the password interface

According to the above operation, before entering each item will first enter a
password input interface to prevent professional staff misuse. The device original
password is “0099”, as shown below, press [<] and [—] keys to switch, press the
[+] and [-] keys to increase and decrease the number of line with the correct
password press “Enter” button to enter.

Password interface

Enter Password

@000
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4.7 Relay setting

Select the “Relay” in the Edit submenu item, press the function key “Enter” to enter
the password screen, enter the correct password to enter the “Relay” submenu, as
Shown below, each item has a checkbox and set values.

1. Ph.OC1: instantaneous overcurrent
Protection
2. Ph.0C2: definite time overcurrent protection

3. Ph.OC3: overcurrent protection
Cold load:
Reclose:

Recl .ACC:
Manu.ACC:

Ph.OV:

Ph.UV:

Power on:
Prepaid:

4. SEF: sensitive earth fault protection

5. Cold Load: cold load pickup

6. Reclose: OC/SEF reclose

7. Recl.ACC: reclosing acceleration protection

DD D E
NN S N

X

8. Manu.ACC: manual closing acceleration
protection
9. PH.QV: over-voltage protection

i

>x< || < >x< 2 X > X< 2 2 > X< >x< 2

10, PH.UV: low-voltage protection

Power Alm:

11, Power on: power on protection
12, Prepaid: debt protection

13, Power Alm: stored energy alarm
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Three sections phase overcurrent

Normal overcurrent

Y
Select Ph.OC menu option press “Enter” key to enter, operational processes as

shown below:

Ph.0C1(1/2)

Pickup current:
®100.0 A

Scp: 00.1 -6000.0

Ph.0C1(2/2)

Delay time :
@.00 S

Scp:0.00-9.99

Step 1: Setting the overcurrent protection
current value, the current value can be
between 0.1A ~ 6000A.

Step 2: Setting the overcurrent delay time, the
delay time can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of simple overcurrent protection setting

Note: Here is a three-stage overcurrent protection period, the use of the other two

are the same.

Sensitive earth fault

B4

Select SEF menu option press “Enter” key to enter, operational processes as

shown below:

/ ?))

Operating mode:

SEF(2/3)

Pickup current:
@o4.0 A

Scp:00.1-999.9

SEF(3/3)
Delay time -
000.1 S

Step 1: Choose the SEF operating mode (1:
Alarm 2: Trip).

Step 1: Setting the SEF protection current
value, the SEF current value can be between
0.1A ~ 999.9A.

Step 2: Setting the SEF delay time, the delay
time can be between 0 ~ 600.0S/M.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of SEF protection setting
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Cold Load

4 .
Select Cold Load menu option press “Enter” key to enter, operational processes

as shown below:

Cold load(1/2)

Pickup current:
[000.0 A

Scp:01.0 -6000.0

Cold load(2/2)

Delay time :
@1.00 S

Scp:0.00-99.99

Step 1: Setting the cold load protection
current value, the current value can be
between 1A ~ 6000A.

Step 2: Setting the cold load delay time, the
delay time can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to modified
current value and delayed time.

The operational processes of cold load protection setting

Automatic reclosing (Reclose)

4 .
Select Reclose menu option press “Enter” key to enter, operational processes

as shown below:

Reclose(1/6)
Reclose count
Seps I =

Reclose(2/6)

Ist delay time:
@4.00 S

Scp:0.00-99.99

Reclose(3/6)
2nd delay time:
@4.00 S

Reclose(4/6)

Jrd delay time:
@4.00 s

Scp:0.00-99.99

Reclose(5/6)

tth delay time:
@4.00 S

Scp:0.00-99.99

Reclose (6/6)

Reset time:
@60 S

Scep:01.2-180.0

Step 1: Choose the reclosing times (1: One,
2: Two, 3: Three, 4: Four).

Step 2: Setting the 1st delay time, the delay
time can be between 0S ~ 99.99S.

Step 3: Setting the 2nd delay time, the delay
time can be between 0S ~ 99.99S.

Step 4: Setting the 3rd delay time, the delay
time can be between 0S ~ 99.99S.

Step 5: Setting the 4th delay time, the delay
time can be between 0S ~ 99.99S.

Step 6: Setting the reclosing reset time, the
reset time can be between 1.2S~ 180.0S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
mode and modified delayed time/reset time.

The operational processes of automatic reclosing setting
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Reclosing acceleration (Recl.ACC)

4 .
Select Recl.ACC menu option press “Enter” key to enter, operational processes

as shown below:

Recl.ACC(1/2)

Pickup current:
0100.0 A

Scp: 00.1 -6000.0

Recl.ACC(2/2)

Delay time :
.00 S

Scp:0.00-9.99

Step 1: Setting the Recl.ACC protection current
value, the current value can be between 0.1A
~ 6000A.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of reclosing acceleration protection setting

Manual closing acceleration (Manu.ACC)

Y
Select Manu.ACC menu option press “Enter” key to enter, operational

processes as shown below:

Manu.ACC(1/3)
Exit time :

9.99 )
Scp:0.10-9.99

Manu.ACC(2/3)
Pickup current:

M100.0 A
Scp: 00.1 -6000.0

Manu.ACC(3/3)

Delay time :
@.00 S

Scp:0.00-9.99

Step 1: Setting the Manu.ACC exit time, the
exit time can be between 0.1S ~ 9.99S.

Step 2: Setting the Manu.ACC protection
current value, the current value can be
between0. 1A ~6000A.

Step 3: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of manual acceleration protection setting
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Over voltage protection (Ph.0OV)

4 .
Select PH.OV menu option press “Enter” key to enter, operational processes as
shown below:

PhOV (1/2) Step 1: Setting the Ph.OV protection voltage
Pickup voltage: value, the voltage value can be between 0V

B50.0 Vv ~ 9999V,
Scp:00.0-999.9

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the

5¢p:0.00-99.99 modified voltage value and delayed time.

The operational processes of overvoltage protection setting

Low-voltage protection (Ph.UV)

V4
Select PH.UV menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the Ph.UV protection voltage
value, the voltage value can be between 0V
~ 999.9V.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Ph.UV(2/2)
Delay time : Note: Press [ | ] key to switch to next screen,
@0.00 s press the [+] and [-] keys to switch the

Scp:0.00-99.99

modified voltage value and delayed time.

The operational processes of low voltage protection setting
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Power on

4 .
Select Power on menu option press “Enter” key to enter, operational processes
as shown below:

Power on(1/2) Step 1: Setting the Power on protection
Pickup voltage: voltage value, the voltage value can be

lso.ov between OV ~ 999.9V.
Scp:00.0-999.9

Step 2: Setting the delay time, the delay time
Power on(2/2) can be between 0S ~ 99.99S.

Delay time : Note: Press [ | ] key to switch to next screen,
e g??? S press the [+] and [-] keys to switch the
5¢p:0.00-99.99 modified voltage value and delayed time.

The operational processes of Power on protection setting

Prepaid (Optional features)

. q :
Select Prepaid menu option press “Enter” key to enter, operational processes
as shown below:

Prepaid (1/1) Step 1: Setting the delay time, the delay time
Delay time : can be between 0S ~ 99.99S.

@0.00 S
Sep:0.00-99.99

Note: Press the [+] and [-] keys to switch the
delayed time.

The operational processes of Prepaid protection setting
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4.8 Save parameter
After setting, press “"ESC” key to exit, if modified below figure will show. If you need
to save press “Enter” key and input password, otherwise press “ESC” key.

Save:Press Enter

Exit:Press Esc

4.9 Parameter set
Press the EDIT — Para, enter the “parameter set”.
Set the communication parameter

Parameter set Parameter set Parameter set
Comml. status Comm2. status Comml. address

[o1

-] N - Scp: 001 -099

Parameter set Parameter set Parameter set

Comm2. address Comml. baud Comm2. baud
[Jo1 [Jo600 0 0]

Sep: 001 =099 Scp: 00000 -38400 N -38400

communication set process

If you want to open the communication, you can set "Comm1.status” to "1”, set
“Comm1.address” to 001 and set “comn1l.baud” to 09600 so the communication is
run. “"Comml.address” is the address of the device, it used to distinguish the
controller, when more than one controller need communication.

Password set

Parameter set The device initial password is “0099”,
the password for the user to modify
from the “0000” ~ “9999”, when revised
press “Enter” key to confirm, enter the

Operate password

: [Joo9
dep: 0000 -9599 password before the modification.
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CT, CTO rate set

Parameter set CT rate is the three phase current rate.
CT rate The value of CT ratio is equal to the
[o0/5 primary side current value divided by
Scp: 001/1 -999/5 the secondary side current value.

Parameter set CTO rate is the real zero sequence
CTO rat current rate. The value of CTO ratio is
g 6@20/1 equal to the primary side current value

. € T divided by the secondary side current
Sep: 001/1 9995 vaiue ) "

Note:

1 Different current transformer, CT ratio becomes different.
2 Different current transformer, CTO ratio becomes different.
Close and trip pulse time set

Parameter set Parameter set
Close pulse time Trip pulse time

060 mS M40 mS
Sep: 010 -999 Sep: 010 -999

“Close pulse time” is the discharge time for close coil. “Trip pulse time” is the
discharge time for trip coil.

Note: Please do not modify the trip and close pulse time.
4.10 Calibration

Select the Edit submenu in “Adj.”, press “Enter” key to enter into the password
screen, enter the correct password to enter the “Adj.” submenu, press the [+] and [-]
keys to correct the value of current and voltage.

Note: All voltage and current values in the factory have been corrected before.
Please do not change the parameter values.
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4.11 Clear report

Select the Edit submenu in “CIr”, press “Enter” key to enter, as shown below:

Select “1”: Clear the trip report.
lear tri

‘lear 1apr Select “2": Clear the alarm report.
le

e

che S OF Select “3": Clear the SOE report.

count

Select "4": Clear the count report.

Select "5”: Clear the all report (include trip
record, alarm record, SOE record and count
record) .

4.12 Factory setting

All the values in the factory have been corrected before. Please do not change the
values.

4.13 View relay and setting

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can

view all the protection is enabled or disabled, select the option press “Enter”

key to enter the value you can view each protection, press the arrow keys to switch
screens.

eI
h.0C2:
IOy

SEF:

Cold load:
Reclose:

Recl .ACC:
Manu.ACC:

Ph.OV:
Ph.UV:

Power on:
Prepaid:

>X< X< 2 2 >< X< X< 2
BB

0o o m

Power Alm:
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4.14 View SOE

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select “"RPT” option press “Enter” key to enter the "RPT” submenu, you can view the
SOE record events, recording events include: trip signal, alarm signal, telemetry
signal (circuit breaker status, whether the manual or remote operation, fault trip,
time and date, etc.) and count signal (the count of trip).

0C=

SEF= 1

Manual= 1(
Remote= 0

4.14 View input signal

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Input” option press “Enter” key to enter the “Input” submenu, you can
view the state of input signal.

[nput show [nput show
Breaker close:1||High gas:

Pfepaid open: 0| Light gas:
High temp: 0llSpring ready: 0
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5.1 RF remote controller

Function of each key
A:Close

B:Trip

C:Unlock

D:Reset

Note:

1. In order to prevent misuse, press the unlock button for 3 seconds, before
execution of the closing operation.

2. The effective distance of RF remote controller is 30 meters.

5.2 Features and the use of external sockets and switches

DZaT-80
ca @
pomeens o
o= ;3}

AC power switch Backup switch Activation button

Note: Before using the controller, ensure that the battery charge enough for 12
hours.

1. The AC power switch is for protecting the Auxiliary PT (Or utility incomer), and the
BACKUP switch is for charging batteries.

2. After charging the batteries, turn off the power switch to protect the batteries for

storage.

3. Activation button is not allowed for pressing last long time, or permanent damage
of battery under-voltage may result.
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5.3 The main secondary component parts

Cable plug, connect the controller and Cable plug, connect the controller to
circuit breakers. offer the power.

Note: For security norms, Surge protector has to be grounded (green line) to the
earth.

5.4 Battery

® RWK-2RC stand-by battery adopts two 7AH lead-acid free of maintenance
batteries, the average battery life exceeds 3 years.

® Please replace the storage battery in time when the storage battery exceeds its
usage life. Replace method as following: firstly push the stand-by power supply
switch to trip position, and pull out the connection cable simultaneously, rotate
the support bolt away, replace the used battery with new battery. Then recover
the device to the original status according to the contrary sequence. Please deal
with the used battery properly in order not to pollute the environment.

5.5 Wireless Router

Wireless Router is a type of compact industrial wireless router, designed to fully meet
the needs of industrial standards and industrial users. It adopts high-powered
industrial 32-bits CPU, multi-layer software detection and hardware protection
mechanism to ensure reliability and stability of the device. It supports worldwide
carrier 4G/3G cellular network FDD-LTE, TD-LTE, and WCDMA, EVDO, TD-SCDMA,
EDGE, CDMA 1Xand GPRS, CAT-M, NBIoT. With rich VPN protocols(IPSEC. PPTP.
L2TP etc.) to ensure the security of data transmission, and rich interfaces, such as
RS232 (or RS485/RS422), Ethernet Port, I/O(Option) and WIFI(Option), etc.
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Danger: The dangerous voltage with the device maybe result in the permanent
damage of equipment or personnel casualty during installing RWK-2RC. These
voltages mainly distributes at terminal bar of device and circuits of AC current input,
AC voltage input, digital input, IGBT output and operation power supply., etc. This
device’s installation, debugging and maintenance can only be operated by technical
staff who has been authorized and trained strictly.

6.1 Installation

450
480

20
50

E Mo — 22 O
C
-3
3

RWK-2RC installation schematic and dimensions
Cabinet installation
Installation of Box Body

® Please fasten it upon support shelf with matched M10 x 20 stainless bolts during
installing the product. (Support shelf is provided by user, please point it out if
needed to be provided by manufacturer)

® As shown above, place it up side. Don't place it up side down or in slope.
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6.2 Maintenance

® If the device is not used, it should be kept in dry and ventilated places indoors,
and charged once every three months, the charging time should be more than
24 hours. Before the device is used, the charging time should not be less than
24 hours. Replace the storage battery each three years.

® This device has storage battery management module, which will automatically
cut off the storage battery output circuit when the storage battery voltage is on
the low side. You should check the storage battery each year, please replace the
storage battery immediately when single storage battery voltage id lower than
DC12v.

® Please firstly make sure the first system is power off before the device is
maintained, forbid inserting or pulling out aeronautical connector under power,
thus avoid CT short circuit happening.

6.3 Parts Attached with the Device
Name Quantity  Collocation Usage or Description
Box door key 2 Standard Open the box

Please read it carefully before
User Manual 1 Standard use the device, RWK-2RC wiring
diagram is attached.

Inspection report 1 Standard Factory inspection report
econtoler 1 Selecle T %0 meters.
Communication 1 Selectable RS485/USB converter or
Interface RS485/RS232 converter
Control Cable 1 Standard 20 cords (6 meters)
Control Cable 1 Standard 2 cords (6 meters)
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7.1 Decommission

Shut-down Power Supply

Shut-down Device Power Supply: Turn off external power supply switch of the device.
Disconnect All Power Cables

Disconnect all power cables connected to the device.

Danger: Before disconnecting all power cables connected to the device power
module, it must confirm that the external power switch is turned off to avoid danger.

Danger: Disconnecting all power cables connected to the device alternating current
module, it must confirm that the equipment corresponding to input alternating
component has stopped operation to avoid danger.

Dismantle from Display Cabinet

When the above steps are completed, loosen the fix screws and dismantle the device
from the display cabinet.

Danger: When neighboring equipment is in operation, it must strictly confirm the
safety distance between the dismantled device and other device in operation and
unskilled professional shall take particular caution.

7.2 Disposal

When dispose decommissioned device, please follow relevant regulations of the
country where the product is used for the disposal of scrapped electronic products.

Caution: It must strictly adhere to relevant regulations of the country where the
product is used for the disposal of scrapped electronic products.
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